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Introduction

Thank you for choosing the movingweather software. This Manual will introduce you to the program
and how to go about using it.

If you wish to find out more information about the program, sales, or are having technical problems
please contact us through one of the options below:

Email us at admin@movingweather.com. This is our most preferred and reliable method of con-
tact for general questions and queries. We would be grateful for contact via email.

For Technical support and software related questions please email support@movingweather.com
or call +44 (0) 870 8610032, Mon - Fri 9am - 5pm (UK local time) and select option 1.

For any other reason you may contact movingweather by calling +44 (0) 870 8610032, Mon - Fri
9am - 5pm (UK local time).

If you would like to discuss becoming a dealer or distributing movingweather, please email
info@movingweather.com

Our details in full are as follows:

Moving Weather Ltd Tel: +44 (0) 870 8610032

PO BOX 704

Haywards Heath Email: admin@movingweather.com
RH16 9EF support@movingweather.com

Pentium PC with a minimum 400MHz processor, 1GHz or higher recommended
1GB of free disk space required
Minimum 1GB of RAM, although more is recommended.

Operating systems Microsoft Windows XP (32-bit and 64 bit), Vista (32-bit and 64 bit) with the latest
service packs, Windows 7 (32-bit and 64 bit) and Server 2008.

SVGA Monitor supporting minimum 256 colours 800x600 (high colour or true colour recommended)



Installing movingweather 3 & Initial Start-up

Installation Process

Installing movingweather is quick and easy.

Once you have downloaded the program from
www.movingweather.com, pleasure ensure that
you fully extract all the files, using WINZIP. Once
you have extracted all the files, please click on
the file marked “Set up”. Then follow the on
screen instructions.

If you see the message on the right please click
on remove, to ensure that all previous copies of
movingweather 3 are removed prior to installa-
tion.

We do however understand that there is a con-
siderable difference from movingweather’s ear-
lier versions to movingweather 3, and so we have
made it possible to have both versions running
on the same computer. This will enable you to

become accustomed yourself to movingweather 3

il Movingweather

Welcome to the Movingweather Setup Wizard

Select whether you want ta repair ar remove Mavingweather.

(%) Repair Movingweather

() Remove Movingeeather

Cancel

at your own convenience.

Starting movingweather
for the first time

When you have installed movingweather 3, there
will be a new icon on your desktop
‘movingweather 3’ (see right).

Double click on this icon to launch
movingweather 3.




Installing movingweather3 & Initial Start-up Cont.

Initial Start-up

Once the program has launched you will see the
Startup Wizard

This menu will only be shown if you do not have
an account registered on the computer:

Make sure you are connected to the
internet

e If you are a new user, and do not have a
subscription to movingweather then please
click ‘I am a new user’. This will take you to
the movingweather website to register.

e If you are a current subscriber and know your
account number and password (same as ver-
sion 2) then click ‘I know my account number
and password’ and enter your details.

e Enter your account number, password, and
then choose an easy to remember computer
name, and press ‘Next’

e The details that you have submitted will be
sent to the movingweather server for authenti-
cation and then an account file will be received
and saved. You will be prompted for your case-
sensitive password once again, please enter,
and click on remember me if you want your
computer to remember your password.

* movingweather will then start.

Regitersccount NI et

s 3n E s - die

movingweather
Before first use you need to create your Movingweather
account. Please choose one ofthe following options:

ﬁ Iam a new user @

@ I know my account number and passward @

Startup wizard

Register account E]

Accounk Ma;
Passwiord:

Compukber narne:

| EBack | | Mexk |

Send request @

Flequest started

Generating request

Flequest generated successfully
Cannecting to the server..
Connected. Sending request. .
Fiequest sent. Loading data. ..
['ata size: 814 bytes

Fesponze received OF,
Fequest complete




Installing movingweather3 & Initial Start-up Cont.

Offline Start-up

In order for you to use movingweather, you
must log on once after installation in order
for the system to validate your account.
Thereafter there is no need to be connected to
the internet to get your forecast if you are using
a satellite or expensive mobile phone tariff to
connect. You can do so using the offline login
and obtain your forecast by email (see page 17)

. Launch the program as normal. You will
then receive a message advising that the
Request to connect to the movingweather
server has failed and suggesting you use
the Offline Login facility.

. Click on Done.

. You will then be asked if you want to login
as offline? If you select yes, the program
will open as normal. If you click no, the
program will close.

Account Verification

Request started
(Ges g T t

=
‘You are not connected to the internet. Please ensure that you either have a
connection to log in, or you use the offiine login faclity. Thank vou

Done

= sy

>>



The Interface Explained

movingweather 3's interface comprises of 3 sections, in addition to the central map:

1. The Top Menu & Toolbar
2. The Time Bar and Forecast Controls

elp.
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#: Movingweather
File Window | Help

@&y P @ |v &« ¥ =K B
1. The TOQ Menu & Toolbar Getforec% vg Back My locations || Pan | SelectArea Zoomin Zoomout Info | Settings Print

e File : gives a drop down menu with:
- Open forecast.. This will open a browser to find any previous forecasts you may have saved.

- Clear Forecast. This will delete your previous forecast.
- Properties... of the forecast gives you details of your forecast inc. when it was last generated.

- Save as. This enables you to save your last forecast.
- Log out. This will take you back to the Start-up wizard to log in with a different account.

- Exit. This closes the program completely.

» Account—this refers you to the Recommend a Friend facility. If your friend uses the promotional
code that is produced here when he/she purchases a subscription, both you and your friend will
receive an additional 3 months subscription for free.

Help— provides details of your software, & access to the user guide, instructional video, upgrade,
FAQ’s, Terms & Conditions and Privacy Statement. You need to be connected to the internet to
access some of this information.
»Get Forecast:- opens a new window from where you can download weather forecasts
@ via the internet or via email. ( See page 15 onwards)

@ « World:- will take you from the current area you are viewing to the World map.

ﬂq » Back :- will take you to the previous map/area you were viewing..

>>




The Interface Explained Cont.

R
e My Locations - lets you add a new favourite’ location, and also go to preset locations

When you start movingweather for the first [ i
time the ‘My Locations’ button list will be un- '
populated. This list can be populated with all of
your ‘most visited’ or ‘favourite’ places. To do
this:

—
Em @B @ 5 a -1 @B
Sl Cb =

A

sz

5] ] ] ] ] )

Zoom using ‘Select Area’, or ‘Zoom +/- (see
page 7) into the place that you want to add
to the list e.g. Caribbean

Then click on ‘My Locations’, and then click
on ‘Add Current Location’

Enter name

You will then need to type in what you want | Lecation name: Caribbean |
this location to be named, and press ‘OK’,
and this area will then be saved

Once you have saved the area you can now
click on ‘My Locations’ and it will appear in
the list. Caribbean
To go straight to a location press the
blue arrow
To select the area via “Select area” Box
press the pin button
To delete a location press the bin

My locations




The Interface Explained Cont.

#: Movingweather

The Top Menu & Toolbar Cont. File Window | Help

W

14

@-@gﬂmcl-i-_g& a5 &

Get forecast World ~ Back My Locations Select Area Zoomin Zoomout Info Settings  Print

ePan- this button will select the Pan tool which will allow you to move around the map by us-
ing the mouse cursor (which will be a hand). To pan around an area select the Pan tool and
then click and hold the left mouse button and drag it towards where you want to go, then re-
lease the mouse button and the map will be redrawn. Please Note: the map will only be
redrawn when the mouse button is released

» Select Area. This button will enable you to select a specific area by holding down your left
mouse button and dragging it to the right and down to create a shaded box. (See below left ).
Then click on the eye glass to accept, the pin to lock the area (this will enable to you select
another area to download a forecast for multiple areas—see below right ) or the X to cancel.

e Zoom In/Zoom Out - these buttons will allow you to zoom into and out of an area. 7he
most effective way to zoom in is to select an area with the “Select button” and then define it
by zooming in closer to the area of interest with the Zoom + button.

eInfo - Info boxes are used to determine _ = — —— =
the weather forecast data for a specific BN e
point on a map. In movingweather 3 you . P Tog

are able to place more than 1 info box on : e

the screen. Once you have download the |{
forecast data you need, ensure the Info
Box Layer is selected as viewable (see
page 14) and move the cursor over onto
the map. You will see that there is a cursor
trailer that has got the Longitude and Lati-
tude of the current point. Click and hold
the mouse button where you want the
precise forecast data for, and then drag to
where you want the info box to go. You
will see a line being drawn from the point to the info box. Repeat the above process if you
want to add multiple boxes to the screen. To remove a box click on the ‘x’ at the top right

hand side of the info box.



The Interface Explained Cont.

#: Movingweather

File Window | Help
@y P B @ |ula # =R |D @&
. Pan | SelectArea Zoomin Zoomout Info | Settings  Print

Get forecast World Back My Locations

2 & Settings. This menu allows you to change your Time Zones, Timing, Display, Layer Manage-
ﬁ' ment and proxy settings.

- Time Zones. please select the zone from the drop down list. This will ensure that your forecasts
are current for your time zone.

- Timing. This enables you to set the time interval between each frame that you view. For exam-
ple you can set it to only download information for every hour on the hour, or you can
download data for every 10 minutes. You can also set the delay between frames when a fore-
cast is playing:

Movingweather settings El

[ Timing | Display | Layer manager |

a. To change the delay between displaying each frame | osay ser dspissing sschframs shen showing sinstin

when showing animation, drag the slider to a point 4
along the delay bar, and press ‘Ok’. The forecast will | , .. o
automatically re-process for you. Interval betwsen consecutive frames
0 hours 10 | mirutes
) Shorter interval produces smoother anination bu reguives more
b. To set the interval between the data downloaded: procesetig poner and iresses processig tme. Longer mterval

reduces processing tine and may redtuce downtbad size.

from 5 minutes to hours, enter the time and click ok,
the forecast will automatically re-process for you.

- Display. This gives you the options to

. || Tme zene | Tming | Display || Layer manager || Proxy |
a. Smoothes th(_a ed_ges of the forecast, only if the_ O B i ey ke ) |
area range is either less than 15 degree lati- (0 St edges (forecast loksbetir)
tude or 15 degree Iongitude. See b9|0W Only smoothif forecastarea is less thar 0[] degrees inany dimension
() Prepare all data after loading
Smoothed Edges UnsmOOthed Edges (=) Prepare only visble data after loading
j— f— M3y raquire processi sibility is changed
e ;
| oK || cancel |

b. state whether you wish all of the weather parameters, ie, shades, lines, values arid values to
always be processed, regardless of whether you have set it to process via the ¥ symbol
(takes longer to process). If you select Prepare only visible data, please note that pressure
grid values, wind arrows, cloud icons, temp grid and humidity grid values will be visible irre-
spective on whether the #& is on, as the data does not need processinn Also, if you have
not selected #& at the time of downloading the forecast, if you select ¥ , then go to Dis-
play> Prepare only visible data>OK, the data will then be processed. There is no need to

download a new forecast.




The Interface Explained Cont.

#: Movingweather

File Window | Help
@~y @ B ol + = K g
| Pan  SelectArea Zoomin Zoomout Info | Settings Print

Get forecast World  Back My Locations

- Layer Manager. This menu allows to toggle between seeing the Layer menu (to the right) or not

= < e = =

ogweather

- Proxy Settings. If your system uses a proxy server, MW3 will automatically detect this and add
your settings here. Do not delete otherwise MW3 wiill stop working. If you accidently de-
lete, you can find out your proxy settings via your Internet explorer/Firefox:

a. Internet Explorer>Internet Opti9ons>Lan Settings>Proxy Server.
b. Firefox> Tools>Options>Advanced>Network>Settings,

. * Print. You are now able to print your movingweather forecasts, either as :-

a Print Options =B ]’

- Text in a CSV print out. Please note, this function |
will export the print out, to enable you to sort the () Export Forecast in Text Only Mode (C5V)
data, due to the volume, as it shows each parame-
ter for each co-ordinate and for each time frame
within the area you have chosen.  [|| ~7TTTTTTTTTmmTmmo s m e

() Print Forecast at Current Interval

(%) Print Forecast in Grapics Mode

- A Graphic. In Graphics Mode, you must choose

whether you want the print out at the time frame () Prit Fareenst abikercnt Perings
as is shown on your screen at the time, or at differ- [l period:  3hours (]

ent time periods as chosen by you. Please note the

no of pages to be printed will vary accordingly. No Of Pages = 15

Once you have made your choice, click OK. Your
printer properties screen will then open and you
can chose your layout, the quality of the print, and
whether to print in greyscale.

10



The Interface Explained Cont.

2. The Time Bar and Forecast Controls
used to control the forecast you are viewing. The but-
tons are only active after downloading a forecast.

Buttons Explained
The time and date of the forecast.

Time cortral

Sun, 10 Jun 2007

21:00

2100 iln 0300 0600

03:00

200 1Si00 1800 2100

(] ] o ] o] ] =

*The black time bar shows preset times throughout the forecast, according to its length.

*The ‘Loop’ enables the forecast to play continuously.

&
I«
«

>
L
I

>

Clears/deletes the forecast permanently
Starts the forecast from the beginning
Rewinds the forecast to any given point.
Play

Fast forward the forecast to any given point
Forward to the end of the forecast

Stop (It is best to stop the forecast before using any of the other controls)

You can also drag the blue triangle to any given point and play the forecast from that point

3. The Layer Menu
The layers menu (to the right hand of your screen)

contains all the controls for changing all the settings
related to the display.

* Map—is the world map

e Populated places—this control whether continent,
country and city names are visible.

e Grid—Longitude and Latitude grid

e Sea-master control for wave & swell elements

« Weather—master control for weather elements, ie
Pressure, Temperature, Rain, Wind, Cloud Cover &
Humidity

e Info—Info box layer

Please note: to get the layers menu maximised;
like above, click on the [+, and all the sub
items will be displayed. You will need to do this
to be able to select what weather elements you
want shown on the forecasts

e The @& symbol toggles the selected layer to be
displayed or turned off by clicking it

e The &/ symbol when clicked will launch a new win-
dow which will display the settings for the selected
item

e You can also create a new layer or delete one using
these buttons.

Layers [ ]
- Map = 7
- Grid = 7

(=) Sea &= 7

lék- Wave = 7
& swell = 7
[~} Weather = 7
ér Pressure = 7
5 Pressure shades = 7
> Isobars &= 7
Pressure values 7
: Grid values 7
lék- Temperature &= 7
El Rain
é- Wind
EI Cloud cover
léf' Humidity
- Info
[+}- Populated places e

L
== &

11



Customising the Display......

In movingweather 3 you are able to customise
just about everything. We have preset what we
consider to be the optimum settings, but you can
of course change your movingweather to suit
you. To do so, firslty ensure you have
downloaded a forecast with all the ele-
ments. Then click on the # next to each layer
in the layers menu and you can change the set-
tings of a particular layer. Below is what each
settings window looks like and what each sefting
does:

Map Settings— Fill Options
Change the colour of the Oceans
Set the transparency of the Ocean colour

These options do the same as above, but for the
land, and internal waters e.g. lakes

Map settings—Coastline _Options

Change the properties, of the normal coastline,
namely where there is a line around the land-
mass, the thickness of that line, the colour and so
on.

Likewise, if is possible to change how you display
each of the weather elements, temperature has
been used as an example:

Once you have clicked on # the settings menu
will come with different Tabs.

General

*Show this layer—tick box that is the master
control to show/hide the whole of the tempera-
ture layer

e Units—this drop down box will show all the
available scales that the weather element can
be shown in.

J Fill options [ Coast line options |
Calour: | [ 100, 148, 237
Transparency:
4
ransparent Solid

Colour: [ 127, 255, 0

Transparency:

Transparent Solid
Internal water

Colour: | I 100, 148, 237

Transparency:

Transparent Solid

|‘ oK | | Cancel |

[ Fill options | Coast line options |

Line width 1 E

Colour: MO, 0,0

Transparency:

Transparent Solid

J‘ General [ Shades || Isclines || Isoline labels || Grid values |

Shaw this layer Prink this layer

Urnits: | Celsius

Temperature settings El

12



Customising the Display......

Shades and lIsolines

«Show this layer—tick box is the control to show/hide just the
shades layer

ePalette—this is the spectrum of the colours that the shades
will be shown for temperature. To change the colour scheme
just double click on one of the triangles underneath the colour
bar, and a palette will appear for you to choose a new colour.
To change the boundaries from one colour to another just
drag the triangles along the colour bar and you will notice the
numbers changing. To remove a boundary just drag the trian-
gle to the end, and re-configure the colour at the end triangle.
Please note that if two boundaries are too close together
the numbers will overlap

eTransparency - this bar defines how transparent the shades
will be depending on the temperature level. The bar will show
you how the map will show behind the shades layer

eSaving and loading palettes— to get the ‘perfect’ palette for
use with movingweather you may need to save the palette
you are customising. To do this just click on the save palette
button, select a location and then press save. To load a pre-
saved palette, just press the ‘Load Palette’ button and then
locate the saved file. Palettes are transferable between
weather elements by using the above save and load method

Isoline labels

« Show this Layer is the same as previous

 Label Text- this is the size, font and colour of the labels that
go with the isolines.

» Label Box— the isoline label has a box around it, these set-
tings are for the outline colour, and also the fill of the box, by
default the colour is set to white, but it is fully transparent. So
to change the fill colour of the box, make the transparency
solid ad then change the colour.

Grid Values-

< Show this Layer is the same as previous

« Draw values - this is the setting to draw more or less values
on the temperature grid. The greater the number the less
values you will see on screen.

« The font and colour is to change the settings for the font and
colour of the grid values.

Temperature settings FS:(

[ General | Shades | solnes || Isoline labels || Grid values |

[] show this layer

[] print this layer

Colour:
-30

Transparency:
-30 45

\: Load palette. . H Save palette. .. |

\: 0K H Cancel \

| Load palette... | | Save paletke. .. |

L — X

lines | Iscline labels | Grid values

[ prink: this layer

[] show this layer

Font:  Werdana, 10pt L‘

Colour; EEEEO, 0,0 (]

Colour: | [ 255, 255, 255 ]

Transparency:

Temperature settings &‘

[General | Shades |[Tsslines || tscline labels | Grid values |

[] Show this layer [ Prink this layer

Draw values every | 40 [ pixels

Fant:  verdana, 10pt \:|

Colour: | IO, 0, 0 =

o) [(icanciis)

>>
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Customising the Display......

Although it is possible to show the settings for all
the generic settings’ options, below are all the
unique settings for individual weather elements:

Wind Arrows-

» Draw arrows - this is the setting to draw more
or less wind arrows on the map. The greater
the number the less values you will see on
screen.

e Arrow type—

e Simple - same size whatever the
wind strength

» Scalable- size is relative to the
wind strength

« Beaufort - will be displayed in
Beaufort feathers

Depending on which arrow type you have se-
lected you will get different options:

Simple:

eArrow points - can define whether the arrows
show wind blowing to or from

eArrow length and width— use these controls to
define these properties

Scalable:

e Arrow points - can define whether the arrows
show wind blowing to or from

*Minimum length— set the minimum arrow length
in pixels at a particular wind strength

*Maximum length - set the maximum arrow
length at a particular wind strength

*Minimum width— set the minimum arrow width
in pixels at a particular wind strength

eMaximum width - set the maximum arrow width
at a particular wind strength

Beaufort:
*Arrow length and Barb size— use these controls
to define these properties.

« Show value lines - draws a line from the arrow
to the value to match them up.

*Show value border— draws a box or line around
the value, depending on whether all or attached
is selected

X

|' zeneral | | wind shades || wind lines | | wind values ] Wind arrows |

Draw arrows every | 100 E pixels

Wind settings

Arrow bype:

Sicalable

Scalable arrow settings

Arrow is pointing in the direction the wind is blowing To

Minimumm arrow length is 20 E pixels at |3
Maximum arrow lengthis | 60 E pixels at |11
Minimum arrow width is 5 E pixels at |3
Maxirmum arrow width is 25 E pixels at |11

Show values

[ show value lines
[ shaw value border
[ Fill walue box

| Ok | | Cancel |

Simple arrow settings

Arrow points in the direction the wind is blowing Ta
Arrow length 40 @ pixels
Arrom width 10 E pixels

Scalable arrow settings

#rrow is pointing in the direction the wind is blowing | To

Mirimum arrow lengthis | 20 E pixels at |3
Mayimum arrow lengthis | 60 E pixels at |11
Mirirmurn arvow width is 5 E pixels &t |3
Maximum arrow widthis | 25 (] pixels at |11

Beaufort arrow settings

50 EI pixels

26 pixels

Arrow length

Barb size

>>
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Customising the Display......

Cloud Icon

e Draw icons - this is the setting to draw more or
less cloud icons on the map. The greater the
number the less icons you will see on screen.

e The first set of icons shows the sun, meaning
the sky is going to be clear

» The second set of icons does not show the sun,
but if there is nothing shown it means that the
sky is going to be clear

e The third set is a grid display showing percent-
age of cloud in the sky

e Show values if above - will only show values if
cloud cover is above selected percentage

The Info Boxes.
You can change the layout of the Info boxes

«Click on &## adjacent to the Settings option in
the layers menu and it will bring up a settings
box.

«In the left hand menu you can choose which
weather parameters you want to see in your
info box, including both the date and time and a
larger clock to show the timing of the forecast
as the animation progresses.

<As you choose a parameter, click Add to move
it into the sample box. This has to be done one
by one. It will always add the item to the top
left hand corner of the sample box, so you need
to then click on it and drag it to wherever you
want it within the box.

«If you wish to remove a parameter, simply click
on it to highlight it within the sample box and
click delete.

*Once you are happy click OK and the layout of
the info box will then change the next time you
use it.

*You are also able to save and re-load the set-
tings in case you want to change the layout
from time to time, simply by clicking on the
Save and Load buttons.

Cloud cover settings

Draw icons every 143 E|

pixels

No
icon
N
bldis Vo
= < e
40%
Show walues if sbove | 37 E‘ %

|' General || Cloud shades || Cloud lines | | Cloud values ] Cloud icons |

X

Boxlayout

A

=)

o) )

Wave height 26.5 kn
Swell height 26.5 kn

[ setas default ] Apply to all boxes

[ |

>>
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Using movingweather 3

When movingweather starts for the first time you will see the
map of the whole world and the layers menu (see right).

Zoom into the area that you want by either using the Select
Area button or the Zoom +/- buttons.

Downloading a Forecast via the Internet

You are now ready to download a forecast. To do this click on o= ) m 4 e
the ‘Get Forecast’ button which is located at the top left hand e

Forecastperiod: |2 days v
side of the screen - :er:nfmap = o
Resolution: (%) 1 Degree () 1/2 Degree
You will then see the ‘Request Data’ window (see right). To
download a forecast, select:- Ll Rain ' -
- The forecast period e :
» Where you want the forecast data for: [ pressure -

e Current map (default),

- Selected areas when you have multiple zoom areas i :
« Any of your preset locations. [ smel =
» The resolution you want. You can only download a maxi- Total: 258Kb
mum of 48 hours of 1/2 degree data
» The weather elements. You will be given offline estimates of Request Response: _
(") Send by email || Response should be sent by email

individual data sizes of the elements and the total download

size. The estimates are calculated for a typical aday taking into

account the elements you have selected. ‘
e The ‘Request method” . Outlook user can now use the o | e |

“send by email” option.
* Click ‘Get Data’

(") Generate and save

(%) Send online

< Your computer will then connect to our server and send the
request
« Once the request has been dealt with you will be shown how

ending request..
. Loading data...
Kb

Responss received OK

much data has actually been downloaded. The internet con- e
. . Mcvingweather is no lenger connected to the internet.
nect will then be dropped and the system will commence proc- || = socesarg coriese
essing the data into the animation. Finehy s ot
i mrp bk
« It will let you know when the weather elements have been e ra e
. .« . . Pressure processing complets
processed and when it has finished press ‘Done’, and you will lcumpme"mmn%hafﬁn.she.i

go back to the map.

| Done

>>
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Using movingweather 3 cont.

Requesting and Receiving a Forecast by Email

Once you have zoomed into an area you are now
ready to request a forecast. To do this click on
the ‘Get Forecast’ button (top left of the screen).
You will then see the ‘Request Data’ window (see
right) Select the weather data you require.

« Select ‘Send by Email’, and press get Data

= You will then get Request Data Status box,
advising you that the offline request is com-
plete.

« Once the email has been created, and is waiting
in your Outbox, the ‘Request Data’ window will
tell you that the ‘Offline Request Complete’

e Close movingweather

» Go to your email software and you may need to
send the email if it is still waiting in your out-
box, or it may have sent automatically.

 After a minute check your inbox and your
forecast will be included in an email as an
attachment. (see right)

» Double click on the attachment, movingweather
will open automatically and the forecast will be
processed.

Within the ‘Request Method@ you will also see:

1. Generate & Save—this enables you to gen-
erate your request with a view to sending
it by email at a later point.

2. Response should be sent by email—this
enables you to generate the request not,
whilst on line, but receive it via email.

Request data

Forecastperiod: |2 days \E

Forecast area: .(.:u!rent map E

Resolution: (*) 1Degree () 1/2 Degree

‘Weather N
Her 1031 Kb
Wind 20,63 Kb
Temperature 10.31 Kb
Pressure 10.31 Kb
Cloud cover 258 Kb
Humidity 258 Kb
e 20,63 Kh
Swell 20.63 Kb

Total: 97.97 Kb
Crrm—

Response:

() Generate and save

() Send online

|’ Cancel || Getdata ]

R

Request started

Offline request complete

Dane ]

Movingweather forecast

forecastreply@movingweather.com
© Sun17/01/2010 09:56
To Chantal Reed

I Message | ' weather.mwfc (213 B]

Movingweather forecast

>>
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Using movingweather 3 cont.

Downloading Weather for multiple areas

One of movingweather 3's advanced capabilities
is the ability to download weather forecast data
for multiple areas:

To download weather for multiple areas:

e Zoom into an area where you want the weather

forecast data for - this would typically be a lar-
ger area than normal

« Still with the zoom tool canture an area but
instead of pressing the |Q button press the pin
down button (& ). Once pressed it will turn to
the left, allowing you to repeat the above proc-
ess until you have all the areas you require

* Your map will look something like this
(depending on how many areas you have
selected

* When you are happy with the areas selected,
click ‘Get Forecast’ (not forgetting to press the
pin on the last area captured!!)

« All that is different, in the way you get the
forecast, is that you need to select ‘Selected
areas’ from the drop down box, instead of
‘Current Map’.

* Once ‘Selected areas is selected you can con-
tinue to get the forecast in the way you nor-
mally would e.g. by email, generate and save,
or over the direct internet

Please note that with ‘Selected Areas’ the
data may overlap the area selected

« If using the direct internet you may want to
close the capture boxes by clicking on the ‘X’ in
the top right hand corner to see the weather
clearly.

Forecast period: |2 days

Forecast area: |5ele_ch_ed areas

Resolution: (=) 1 Degree () 1/2 Degree

Rain
Wind

[ Cloud cover
[ Humidity
Cwave

[ swell

Total:

Request: Response:
() send by email [ Response should be sent by email

() Generate and save

(%) Send online
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Using movingweather 3 cont.

Playing the Forecast

Once you have downloaded and processed the
forecast, closed the ‘Request Data’ window, you
will be shown the start of the forecast.

«If you want to view a particular weather
element then the @& symbol next to the element
needs to be visible. (see right). Once you have
made sure that all the elements that you require
on the screen are visible then you are ready to
play the forecast. If you have downloaded
the weather parameter, after clicking
on & for shades for example, and
shades are not shown, go to Settings, Dis-
play and select button for Prepare only
visible data after loading, followed by OK.
The forecast will then re-process and you
will see your shades.

*Once you have selected the data you wish to
view, use the Time Bar controls to activate the
animation.

Saving the Forecast

Once you have downloaded a forecast, you can
save it, so should you need to close moving-
weather, you can reload the forecast when you
open it again, without having to download it
again.

Click on File, and select “Save as” from the drop
down menu. Then name and save it on your
computer where you like.

*To reload it, again click on File and select “Open
Forecast” , a browser will open and you then
need to find where you saved the file and dou-
ble-click on the file. The forecast will then load
automatically and you can start playing it.

Layers %]
EE

- Map = 7
- Grid = 7
=) sea = 7
- Wave = 7
< Swell - 7
(=} Weather = 7
E] Pressure - 7
. - Pressure shades = 7
= 7
- Pressure values 7
- Grid values V4
- Temperature = 7
- Rain e
[{} wind rd
- Cloud cover & 7
E ramn =
- Info = 7
[} Populated places V4

Sun, 10 Jun 2007
A

ZEOD M1dn 030D DE:00

02:00

jz00 1500

10D 21:00

] o o] ] ] ] = >

>>
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Uninstalling movingweather 3

To uninstall any version of movingweather, go to
Control Panel-> Add/Remove Programs, find
movingweather and click on it and then click
Remove, the Setup process will guide you
through the un-installation process.

& program Files

File Edt Vien Favortes Tools Help

After uninstalling the software you must also Qs © (8| Do e | T

delete any potentially remaining movingweather |.....o cowmne

icrosoft Frontpage

oJ

'/” Mirosoft SO Server
1

Gt

| Wicrosoft Activesync

program files . This is also a simple process. ]
Click on Start, followed by My Computer. In @ g (] s
b

Ty Add or remave
rams

the new window double click on (C:), and then o L N

folders | Microsoft wse Microsoft NET

in the next window double click on Program
Files. Here you should find the folder cie i s AR () o i £ e

]} Rename this folder Open

movingweather. Right click on this folder and ||| & wevrs . |
. ) Copy thisoder .J SN Garming Zone [
select the delete option. @ it e o L sy,
L7 Share this Folder = Netheeting = Sean with Norton AntiVinus
g;mai\t;s;u:jer‘sﬁles 'J L= sendTo 3
You must also then empty your Recycle Bin Lttt (] s P
(located on your desktop) to permanently T S
delete these files. = =

() Shered Docuents o= =
My i Otk Express blopeties
My Computer = | |




